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Note: The product name Scout NG Enterprise changed to Scout Enterprise. But Scout NG still exists 
and the license type is still called Scout NG. 

1 Migration from Scout eL to Scout Enterprise   
 
This chapter describes the installation of Scout NG Enterprise with the Recovery components. Please 
install the recovery components to the system which contains Scout eL. If you want to transfer Scout 
to another hardware at the same time please consult chapter 2. Migration from Scout eL to Scout 
Enterprise with Server Transfer. 

1.1 Requirements 

• Scout eL Server must be installed. You need administrator rights to this system.  
• Scout Enterprise setup program The Scout NG Enterprise setup is included on the eLux NG 

CD-ROM, which either comes with your delivery or can be downloaded from our website 
http://www.myelux.com/ (“ELIAS, Scout, EBK > Scout NG Enterprise / ELIAS NG”). 

• System requirements Scout Enterprise needs a system with Windows 2000 Workstation (or 
higher), Windows XP Professional or Windows 2003 Server, Service Pack 1. 

• FTP or HTTP Server. You must have access to the root directory and at least 380 MB harddisk 
space, since the eLux NG container (the eLux NG software packges are stored in it) will be 
installed here. 

1.2 Creating a Backup 

Please do not uninstall the Scout eL Server nor the Scout eL licenses, unless you have saved your 
currently valid configuration. 
For the backup please copy the installation directory of your current Scout eL installation (e.g.: 
C:\\Programs\Unicon\ScouteL).  

1.3 Installing Scout NG Enterprise 

Logon as administrator and insert the eLux NG CD into the CD-ROM drive of your Windows system. If 
the Autorun function of the CD-ROM drive should be inactivated, start the CD in Windows > 
setup.exe. Alternatively, the Scout NG Software is available for download on www.myelux.com. When 
the software has been downloaded, start with Setup.exe in the Scout NG directory. 
 

1. The InstallShieldWizard offers you the options Typical or Custom for the installation. Please 
choose Custom and modify the destination folder to the currently valid Scout eL installation 
directory. 
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2. Next step is to define the database system in use. If you should not use any database system 

yet, select Microsoft Jet Database Engine (MDB). Otherwise select the database you want to 
use and enter the server name / IP address and your user name to access the database.  

 
NOTE Configuration and licenses will not be transferred automatically after the installation of the 
Scout NG Enterprise Server. However, an import tool is provided. Please follow the instructions for the 
import of the configuration described in the next chapter: Import of a Configuration from Scout eL 
to Scout NG Enterprise. 
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1.4 Import Configuration from Scout eL to Scout Enterprise 

From Start > Programs >Scout NG start the Import tool. 
• Press the ‘...’ button and select the ini-file in the directory of  the existing Scout NG configuration.  

If you have installed Scout NG Enterprise in the same directory as the existing Scout NG the 
directory should be preset correctly. 

• Device password: enter device password (Options - Base configuration – Setup – Security) to 
verify that the existing configuration will be imported. 

• Manager password: Scout NG manager password (default: elux) 

• Select the Database type and fill in the necessary fields. 
• Click Import. 
• Depending on the size of the existing Scout NG configuration and the selected database model 

the import may take quite a while. 
• The current status and detected errors, if any, are displayed in the progress area of the Import 

Tool. 

device 
password 

management 
password 

select ini-file 

select 
database type 

 

NOTE: If you import the configuration to the same server on which the old Scout eL version has 
been running, all the licenses will be imported, too, and will be visible in Scout NG Enterprise.  

 

1.5 Possible Error Message 

This message may appear, if "Path to existing configuration" is entered in UNC notation. 

 
In this case set the permission for the share on the remote system to 'change'. 
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1.6 Entering New Licenses 

  
Chapter 10.1 Licenses provides an overview of the license types. 
Please proceed as follows after the installation of the Scout Enterprise Server: 

1. Logon to Scout Enterprise  
2. Enter the Scout NG or Update Scout eL  Scout NG management licenses. They can be 

used immediately. Please activate them within the activation period (30 days) on 
http://www.myelux.com/. After that period the licenses will be invalid, if not activated. 
However, they can still be activated after this period. 

 

NOTE: If you have been provided with Update Scout eL  Scout NG licenses, the old 
Scout eL licenses must be entered in Scout Enterprise, too. They can be reactivated. 

 
3. Enter the eLux NG or eLux NG+Scout(built-in) or Update eLux 1.x  eLux NG licenses, if 

these have been delivered separately, i.e. not integrated in the client. Non-integrated license 
base keys must be entered in Scout Enterprise and activated in the Product Activation 
Center on http://www.myelux.com/. 

You find detailed information on the activation of licenses in our Scout Enterprise Administrator's 
Manual. 
 

1.7 Uninstall Scout eL 

When you succeeded to update Scout eL to Scout Enterprise, you may uninstall your Scout eL 
installation via Start > Settings > Control Panel > Software from the system. 
 

http://www.myelux.com/
http://www.myelux.com/
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2  Migration from Scout eL to Scout Enterprise with Server Transfer  
 
This chapter describes the migration of Scout eL to Scout Enterprise with changing the server 
hardware at the same time. We provide the complete information on the installation of Scout  
Enterprise with the recovery components, on the import of the server configuration of your Scout eL 
installation as well as on the reactivation of your Scout eL licences and the licensing in Scout 
Enterprise.  

2.1 Requirements 

• Scout eL Server must be installed. You need administrator rights on both the Scout eL Server 
system (source) and the Scout Enterprise system (target). 

• Scout Enterprise setup program The Scout Enterprise setup is included on the eLux NG CD-
ROM, which either comes with your delivery or can be downloaded from our website 
http://www.myelux.com/ (ELIAS, Scout, EBK > Scout Enterprise / ELIAS NG). 

• System requirements Scout Enterprise needs a system with Windows 2000 Workstation (or 
higher), Windows XP Professional or Windows 2003 Server, Service Pack 1. 

• FTP or HTTP Server You must have access to the root directory and at least 380 MB harddisk 
space, since the eLux NG container (the eLux NG software packges are stored in it) will be 
installed here. 

2.2 Creating a Backup 

Please do not uninstall the Scout eL Server nor the Scout eL licenses, unless you have saved your 
currently valid configuration. 
For the backup please copy the installation directory of your current Scout eL installation and 
make it accessible for the new server platform.  

2.3 Installing Scout Enterprise 

Logon as administrator and insert the eLux NG CD into the CD-ROM drive of your Windows system. If 
the Autorun function of the CD-ROM drive should be inactivated, start the CD in Windows > 
setup.exe. Alternatively, we provide the Scout Enterprise Software on www.myelux.com for download. 
When the software has been downloaded, start with Setup.exe in the Scout Enterprise directory. 
 
1. The InstallShieldWizard offers you the options Typical or Custom for the installation. In case of 

Typical the most frequently used services are installed automatically. When you select Custom 
you can define which Scout Enterprise components are to be installed (Scout Enterprise Server, 
Scout Enterprise Console, Recovery components, BootP Server).  

http://www.myelux.com/
http://www.myelux.com/


 
2. Next step is to define the database system in use. If you should not use any database system yet, 

select Microsoft Jet Database Engine (MDB). Otherwise select the database you want to use and 
enter the server name / IP address and your user name to access the database.  

 
 
 
NOTE Configuration and licenses will not be transferred automatically after the installation of the 
Scout Enterprise Server. However, an import tool is provided. Please follow the instructions for the 
import of the configuration described in the next chapter: Import of a Configuration from Scout eL 
to Scout Enterprise. 
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2.4 Import Configuration from Scout eL to Scout Enterprise  

 
From Start > Programs >Scout Enterprise start the Import Tool. 
• Press the ‘...’ button and select the ini-file in the directory of  the existing Scout eL configuration. If 

you have installed Scout Enterprise in the same directory as the existing Scout eL the directory 
should be preset correctly. 

• Device password: Enter the device password (Options - Base configuration – Setup – Security) to 
make sure that the existing configuration will be imported. 

• Manager password: The Scout manager password (default: elux) 

• Select the Database type (MS Access in case of using the Microsot Jet Database Engine) and fill 
in the necessary fields. 

• Click Import. 
• Depending on the size of the existing Scout eL configuration and the selected database model the 

import may take quite a bit. 
• The current status and detected errors, if any, are displayed in the progress area of the Import 

Tool. 

device 
password 

management 
password 

select ini-file 

select 
database type 

 
 

2.5 Possible Error Message 

This message may appear, if "Path to existing configuration" is entered in UNC notation. 

 
In this case set the permission for the share on the remote system to 'change'. 
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Important: Scout licenses are not automatically transferred to the new server, but must be 
reactivated to the host-id of the new server in the Product Activation Center of  
http://www.myelux.com  (see chapter 2.6 Reactivating Scout eL Licenses). This is why the 
following message will pop up three times during the import of the Scout eL configuration (for 
local, served and client licenses).  

 
In this case management licenses must be reactivated and re-entered into Scout Enterprise. 
 

Note: 3rd Party licenses are stored on the clients. This is why they cannot and need not be 
reactivated nor re-entered at the new server. If not all of the product licenses should have been 
used before server transfer, please inform UniCon Software GmbH (sales@unicon-ka.de) 
requesting a new license certificate for the licenses not used so far. Please save the .db files of 
the old Scout installation, because these show the quantity of licenses already in use. 

2.6 Reactivating Scout eL Licenses 

Scout eL licenses are to be reactivated on http://www.myelux.com. After the Login please open the 
Product Activation Center, select the relevant Scout eL license and start the reactivation procedure by 
clicking the button „Reactivate“. Providing the host id of your new server you will get an activation 
code which is to be entered in your Scout Enterprise server.  
Note: Product licenses like eLux 1.x licenses as well as 3rd party licenses need not and cannot be 
reactivated, because they are stored on the clients. 

 

2.7 Entering New Licenses 

Chapter 10 Licenses provides an overview of the license types. 
Please proceed as follows after the installation of the Scout NG Enterprise Server: 
1. Logon to Scout NG Enterprise  
2. Enter the Scout NG or Update Scout eL  Scout NG management licenses. They can be used 

immediately. Please activate them within the activation period (30 days) on 
http://www.myelux.com/. After that period the licenses will be invalid, if not activated. However, 
they can still be activated after this period. 

NOTE: If you have been provided with Update Scout eL  Scout NG licenses, the old Scout eL 
licenses must be entered in Scout Enterprise, too. They can be reactivated. 

3. Enter licenses of type eLux NG or eLux NG+Scout(built-in) or Update eLux 1.x  eLux NG or 
Update eLux 1.x  eLuxNG+Scout(built-in), if these have been delivered separately, i.e. not 
integrated in the client. Non-integrated license base keys must be entered in Scout Enterprise and 
activated in the Product Activation Center on http://www.myelux.com/.  

Detailed information on license reactivation is provided in our Scout Enterprise administrator’s guide. 

2.8 Uninstall Scout eL 
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When you succeeded to update Scout eL to Scout NG Enterprise, you may uninstall your Scout eL 
installation via Start > Settings > Control Panel > Software from the system. 
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3 Migration from Scout NG to Scout Enterprise  
 
This chapter describes the migration from Scout NG to Scout Enterprise on the same hardware. If you 
wish to change the hardware at the same time please consult chapter 4 Migration from Scout NG to 
Scout Enterprise with Server Transfer. 

3.1 Requirements 

• Scout NG Server must be installed. You need administrator rights to this system.  
• Scout Enterprise setup program The Scout Enterprise setup is included on the eLux NG CD-

ROM, which either comes with your delivery or can be downloaded from our website 
http://www.myelux.com/ (“ELIAS, Scout, EBK > Scout Enterprise / ELIAS NG”). 

• System requirements Scout NG Enterprise needs a system with  
o Windows 2000 Workstation (or higher), Windows XP Professional or Windows 2003 Server, 

Service Pack 1. 
o 30 MB Harddisk space 
o Database system, e.g. the Microsoft Database Jet Engine (MDB) included in Windows or 

optional: Microsoft
®
SQL Server oder MySQL

® 
Server. 

3.2 Creating a Backup 

Please do not uninstall the Scout NG Server nor the Scout NG licenses, unless you have saved your 
currently valid configuration. 
For the backup please copy the installation directory of your current Scout NG installation and make it 
accessible for the new server platform.  

3.3 Installing Scout Enterprise 

Logon as administrator and insert the eLux NG CD into the CD-ROM drive of your Windows system. If 
the Autorun function of the CD-ROM drive should be disabled, start the CD in Windows > setup.exe. 
Alternatively, we provide the Scout Enterprise Software on www.myelux.com for download. When the 
software has been downloaded, start with Setup.exe in the Scout Enterprise directory. 

 
1. The InstallShieldWizard offers you the options to repair, modify or remove the Scout NG 

server. Please select „Repair “. 
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2. Next step is to define the database system in use. If you should not use any database system 

yet, select Microsoft Jet Database Engine (MDB). Otherwise select the database you want to 
use and enter the server name / IP address and your user name to access the database.  

 

NOTE Configuration and licenses will not be transferred automatically after the installation of the 
Scout Enterprise Server. However, an import tool is provided. Please follow the instructions for the 
import of the configuration described in the next chapter: Import of a Configuration from Scout NG 
to Scout Enterprise. 
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3.4 Import of a Configuration from Scout NG to Scout Enterprise 

From Start > Programs >Scout Enterprise start the Import Tool. 
• Press the ‘...’ button and select the ini-file in the directory of  the existing Scout NG configuration. If 

you have installed Scout Enterprise in the same directory as the existing Scout NG the directory 
should be preset correctly. 

• Device password: enter device password (Options - Base configuration – Setup – Security) to 
verify that the existing configuration will be imported 

• Manager password: Scout NG manager password (default: elux) 

• Select the Database type (MS Access in case of using the Microsot Jet Database Engine) and fill 
out the necessary fields. 

• Click Import. 
• Depending on the size of the existing Scout NG configuration and the selected database model 

the import may take quite a long time. 
• The current status and detected errors, if any, are displayed in the progress area of the Import 

Tool. 

device 
password 

management 
password 

select ini-file 

select 
database type 

3.5 Possible message 

This message may appear, if "Path to existing configuration" is entered in UNC notation. 

 
In this case set the permission for the share on the remote system to 'change'. 
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4 Migration from Scout NG to Scout Enterprise with Server Transfer 
 
This chapter describes how to migrate from Scout NG to Scout Enterprise changing the hardware at 
the same time. It contains all necessary information to install Scout Enterprise with the Recovery 
components, to import the configuration and data of your Scout NG installation, and to reactivate your 
Scout NG licenses for the new server hardware. 

4.1 Requirements 

• Scout NG Server (source) must be installed. You need administrator rights for this system. 
• You also need administrator rights for the target system on which you want to install the Scout 

Enterprise server. 
• Scout Enterprise setup program The Scout Enterprise setup is included on the eLux NG CD-

ROM, which either comes with your delivery or can be downloaded from our website 
http://www.myelux.com/ (“ELIAS, Scout, EBK > Scout NG Enterprise / ELIAS NG”). 

• System requirements Scout Enterprise needs a system with Windows 2000 Workstation (or 
higher), Windows XP Professional or Windows 2003 Server, Service Pack 1. 

• FTP or HTTP Server You must have access to the root directory and at least 380 MB harddisk 
space, since the eLux NG container (the eLux NG software packges are stored in it) will be 
installed here. 

4.2 Creating a Backup  

Please do not uninstall the the Scout NG Server nor the Scout NG licenses, unless you have saved 
your currently valid configuration. 
For the backup please copy the installation directory of your current Scout NG installation and make it 
accessible for the new server platform.  

4.3 Installing Scout Enterprise 

Logon as administrator and insert the eLux NG CD into the CD-ROM drive of your Windows system. If 
the Autorun function of the CD-ROM drive should be inactivated, start the CD in Windows > 
setup.exe. Alternatively, we provide the Scout Enterprise Software on www.myelux.com for download. 
When the software has been downloaded, start with Setup.exe in the Scout NG directory. 

 
1. The InstallShieldWizard offers you the options Typical or Custom for the installation. In case of 

Typical the most frequently used services are installed automatically. When you select Custom 
you can define which Scout Enterprise components are to be installed (Scout Enterprise Server, 
Scout Enterprise Console, Recovery components, BootP Server).  

http://www.myelux.com/
http://www.myelux.com/


 
2. Next step is to define the database system in use. If you should not use any database system yet, 

select Microsoft Jet Database Engine (MDB). Otherwise select the database you want to use and 
enter the server name / IP address and your user name to access the database.  

 
 
NOTE Configuration and licenses will not be transferred automatically after the installation of the 
Scout Enterprise Server. However, an import tool is provided. Please follow the instructions for the 
import of the configuration described in the next chapter: Import of the Scout NG Configuration into 
the Scout Enterprise Database. 
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4.4 Import of the Scout NG Configuration into the Scout Enterprise Database 

From Start > Programs >Scout Enterprise start the Import Tool. 
• Press the ‘...’ button and select the ini-file in the directory of  the existing Scout NG configuration. If 

you have installed Scout Enterprise in the same directory as the existing Scout NG the directory 
should be preset correctly. 

• Device password: Enter the device password (Options - Base configuration – Setup – Security) to 
make sure that the existing configuration will be imported. 

• Manager password: Enter the Scout NG manager password (default: elux) 

• Select the Database type (MS Access in case of using the Microsot Jet Database Engine) and fill 
out the necessary fields. 

• Click Import. 
• Depending on the size of the existing Scout NG configuration and the selected database model 

the import may take quite a long time. 
• The current status and detected errors, if any, are displayed in the progress area of the Import 

Tool. 

device 
password 

management 
password 

select ini-file 

select 
database type 

 

4.5 Possible Message 

 
This message may appear, if "Path to existing configuration" is entered in UNC notation. 
In this case set the permission for the share on the remote system to 'change'. 
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NOTE: Scout licenses are not automatically transferred to the new server, but must be 
reactivated to the host-id of the new server in the Product Activation Center of  
http://www.myelux.com  (see chapter 4.6 Reactivating Scout NG Licenses). This is why the 
following message will pop up three times during the import of the Scout NG configuration (for 
local, served and client licenses).  

 
In this case managment licenses must be reactivated and re-entered into Scout Enterprise.  
 

Note: Product licenses (such as eLux NG or eLux NG+Scout(built-in) as well as 3rd Party licenses) 
are stored on the clients. This is why they cannot and need not be reactivated nor re-entered at 
the new server. If not all of the product licenses should have been used before server transfer, 
please inform UniCon Software GmbH (sales@unicon-ka.de) requesting a new license certificate 
for the licenses not used so far. Please save the .db files of the old Scout installation, because 
these show the quantity of licenses already in use. 

 

4.6 Reactivating Scout NG Licenses 

In case of server transfer Scout NG licenses are to be reactivated on http://www.myelux.com. After the 
Login please open the Product Activation Center, select the relevant Scout NG license and start the 
reactivation procedure by clicking the button „Reactivate“. Providing the host id of your new server you 
will get an activation code which is to be entered in your Scout Enterprise server.  
Note: Product licenses like eLux NG or eLuxNG+Scout(built-in) as well as 3rd party licenses need not 
and cannot be reactivated, because they are stored on the clients. 

 

4.7 Entering New Licenses 

10.1 License Types provides an overview of the license types. 
Please proceed as follows after the installation of the Scout Enterprise Server: 
1. Logon to Scout Enterprise  
2. Enter the Scout management licenses. They can be used immediately. Please activate them 

within the activation period (30 days) on http://www.myelux.com/. After that period the licenses will 
be invalid, if not activated. However, they can still be activated after this period. 

3. Enter the eLux NG (eLux NG or Update eLux 1.x  eLux NG) licenses, if these have been 
delivered separately, i.e. not integrated in the client. Non-integrated license base keys must be 
entered in Scout Enterprise and activated in the Product Activation Center on 
http://www.myelux.com/. 

Detailed information on license reactivation is provided in our Scout Enterprise administrator’s guide. 

4.8 Uninstall Scout NG 

When you succeeded to update Scout NG to Scout Enterprise, you may uninstall your Scout NG 
installation via Start > Settings > Control Panel > Software from the system. 
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5 Scout Enterprise Server Transfer 

5.1 Requirements 

• You need administrator rights on the target system of the Scout Enterprise installation. 
• Scout Enterprise setup program The Scout Enterprise setup is included on the eLux NG CD-

ROM, which either comes with your delivery or can be downloaded from our website 
http://www.myelux.com/ (“ELIAS, Scout, EBK > Scout Enterprise / ELIAS NG”). 

• System requirements Scout Enterprise needs a system with  
o Windows 2000 Workstation (or higher), Windows XP Professional or Windows 2003 Server, 

Service Pack 1. 
o 30 MB Harddisk space 
o Database system, e.g. the Microsoft Database Jet Engine (MDB) included in Windows or 

optional: Microsoft
®
SQL Server oder MySQL

® 
Server. 

5.2 Server Transfer Scout Enterprise > 8.5.0: Licensing 

When transferring the Scout Enterprise Server, version 8.5.0 or higher to another hardware, the 
Scout NG licenses need not be reactivated any longer. Since Scout Enterprise version 8.5.0 the Scout 
licenses are mapped to a universal host id.  

5.3 Server Transfer Scout Enterprise < 8.5.0: Licensing 

When transferring the Scout Enterprise Server lower than version 8.5.0 to another hardware, your 
Scout licenses must be reactivated, in order to enable entering these on the new server hardware. 

5.4 Creating a Backup of your MDB file 

Before uninstalling the Scout Enterprise Server please make a backup of your currently valid mdb file 
(e.g. C:\\Programs\UniCon\Scout Enterprise\ScoutNG.mdb).  
This backup file should be made accessible for the new server platform, e.g. on a network drive. 

5.5 Installing Scout Enterprise 

Logon as administrator and insert the eLux NG CD into the CD-ROM drive of your Windows system. If 
the Autorun function of the CD-ROM drive should be inactivated, start the CD in Windows > 
setup.exe. Alternatively, we provide the Scout Enterprise Software on www.myelux.com for download. 
When the software has been downloaded, start with Setup.exe in the Scout NG directory. 

 
1. The InstallShieldWizard offers you the options Typical or Custom for the installation. In case of 

Typical the most frequently used services are installed automatically. When you select Custom 
you can define which Scout Enterprise components are to be installed (Scout Enterprise Server, 
Scout Enterprise Console, Recovery components, BootP Server).  

http://www.myelux.com/
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2. Next step is to define the database system in use. If you should not use any database system yet, 

select Microsoft Jet Database Engine (MDB). Otherwise select the database you want to use and 
enter the server name / IP address and your user name to access the database.  
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5.6 Import of the Configuration Data  

 
This chapter describes the required steps to import your data from the existing database to the new 
Scout Enterprise installation. 
 

• MySQL Server 

All configuration data of your „old“ installation reside on a central database, so that these data 
are accessible without an import. You have already defined the access to the database 
during the installation by entering the IP address rsp. the host name and the user speci-
fication. 

 
• Microsoft SQL-Server 

When using a SQL-Server database all configuration data of your „old“ installation also reside 
on a central database, so that these data are accessible without an import. You have 
already defined the access to the database during the installation by entering the IP address 
rsp. the host name and the user specification. 

 
• Microsoft JET Database Engine (MDB) 

For safety reasons, please create a backup of the file “ScoutNG.mdb”. Close your Scout 
Enterprise application and copy the file ScoutNG.mdb into your installation directory (e.g.: 
C:\\Programs\UniCon\ScoutEnteprise\ScoutNG.mdb). Then you may logon to the Scout 
Enterprise Server as usual. All configurations, devices and licenses should be available as 
before. If there should not be a Scout NG license against all expectations, it must be 
reactivated and assigned to the host-id of the new hardware. 

5.7 Reactivating Scout Licenses 

Only in case the Scout licenses should not be availabe on the new Scout Enterprise server after the 
server transfer, the Scout licenses are to be reactivated on http://www.myelux.com. After the Login 
please open the Product Activation Center, select the relevant Scout license and start the reactivation 
procedure by clicking the button „Reactivate“. Providing the host id of your new server you will get an 
activation code which is to be entered in your Scout Enterprise server.  
Note: Product licenses like eLux NG or eLuxNG+Scout(built-in) as well as 3rd party licenses need not 
and cannot be reactivated, because they are stored on the clients. 

 

5.8 Entering New Licenses 

Chapter 10 Licenses provides an overview of the license types. 
Please proceed as follows after the installation of the Scout Enterprise Server: 

1. Logon to Scout Enterprise. 
2. Enter the Scout NG management licenses. They can be used immediately. Please activate 

them within the activation period (30 days) on http://www.myelux.com/. After that period the 
licenses will be invalid, if not activated. However, they can still be activated after this period. 

 
Detailed information on license reactivation is provided in our Scout Enterprise administrator’s guide. 

http://www.myelux.com/
http://www.myelux.com/
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6 Migration from eLux 1.x to eLux NG via Firmware Update 
This chapter describes the migration from eLux 1.x to eLux NG. Select ONE of the 3 methods:  

• Firmware Update 
• Recovery via Network 
• Recovery from CD 

To perform a migration, you must have eLux 1.1 installed (if you are using 1.0, either update to 1.1 
first, or perform the network or CD recovery described in this paper).  

6.1 Requirements 

• Thin Client with eLux 1.1. The devices must be managed by Scout NG. 
• Scout NG Server (Version 5.2.4 or higher) with ELIAS NG (Version 5.2.3 or higher) or 

Scout NG Enterprise 
• LAN connection 
• eLux 1.1 Container 
• eLux NG Container with BaseOS 1.2-2 or higher 
• FTP or HTTP server. You require access to the server where the 1.1 container and NG 

container are installed. It can, but does not have to be, the same machine. 

6.2 eLux NG Migration Installer 

This section assumes you are familiar with working with image definition files (IDFs) using the 
software ELIAS NG. ELIAS NG is not described in this paper. For information on how to use 
ELIAS NG, please see the Scout Enterprise Administrator’s Guide.  
To prepare the eLux 1.1 IDF for migration, proceed as follows: 

1. Log on to the Web site www.myelux.com. Under Download click eLux software packages. 
This opens the Available containers page. In the “eLux 1.1” area select your hardware 
platform (Futro B100 or Futro D100) and click the link under “Hotfix packages.” This will 
redirect you to the hotfix page. 

2. Download the package eLuxNG Migration installer. It will be in *.tgz format. This package 
enables you to install eLux NG via firmware update and the existing network setup (otherwise 
you will have to perform a recovery). Save it to your PC. 

3. Quit the Internet. Unzip the file you just downloaded. 
4. Start ELIAS NG. 
5. Open the eLux 1.1 container for your hardware. 
6. Import the unzipped package using the command Container > Import package. 
7. In ELIAS NG open the IDF currently installed on the thin client and add the package “eLux NG 

Migration installer”. You may have to remove packages to keep the IDF from exceeding the 
flash size. 

8. Save the new image. 

6.3 eLux NG Container Settings 

The eLux NG Migration Installer causes the Thin Client to retrieve an eLux NG IDF over the 
network from the update server (FTP or HTTP server) and install it on the device. 
Normally, the update server parameters are set during Scout installation. If you used default 
settings, no further configuration is required. Go to the next section. 
If you are using a different update server, or if your container path has changed since installation, 
or if you wish to specify the eLux NG IDF to install, you will have to reconfigure the parameters. 
The procedure is described below. 

http://www.myelux.com/


Migration and Server Transfer Build # 11 20 
 

1. Log on as administrator to the Scout NG (or Enterprise) Server.  
2. Select Recovery settings from the Options menu. 
3. Enter the update server protocol:  

• HTTP if the update server is an HTTP server. Enter the proxy IP address or name, and the 
proxy port number, if used (optional). 

• FTP if the update server is an FTP server. We recommend you access the FTP server 
using a user account. However, “anonymous” FTP is supported. 

Enter the remaining update server settings: 
• Server Enter the IP address or name of the update server. 
• Username and password. If no username or password is defined for the server, enter elux 

as the password and username. Do not leave blank. 
• Path Enter the following: eluxng/__CONTAINER__ 
• The text “__CONTAINER__” is a macro in eLux NG. During the update procedure, the 

device’s hardware type will automatically be detected and the macro text 
“__CONTAINER__” will be replaced with the correct container name. 

• Image file Enter the following: recovery__SIZE__.idf 
The text “__SIZE__” is a macro. During the update procedure, the device’s flash size will 
automatically be detected and the correct recovery IDF will be installed. Alternatively, you 
can enter the name of the NG IDF you wish to install. Note that in this case the NG IDF 
may not exceed the flash size of the device. 

For more information on macros, please see the Scout NG Administrator’s Guide. 
4. Save the Scout NG (or Enterprise) configuration. 
5. Restart the devices. These settings will be converted to an environment variable and 

transferred to the device. 
It is mandatory to restart the devices before continuing. 

 

Warning The devices must be managed by Scout NG or Scout Enterprise for the container 
settings to be transferred. 

6.4 Initiating the Update 

The procedure is initiated when you install the eLux NG Migration Installer on the device. 
First, go to Setup > Firmware for the device(s) and deselect “Check for update on boot”. 
Next, install the 1.1 IDF you created as described in 6.3. You can update an individual device or 
group/organization unit from the context menu (right click on the device > Update) or all devices 
from the Command Scheduler (View menu > Schedule). 
If the configuration is correct, the procedure will run automatically. No further effort is required on 
the part of the administrator. 



 

7 Migration from eLux 1.x to eLux NG via Network Recovery 

7.1 Requirements 

• Thin Client. The BIOS of the Thin Client must support “Pre-Execution Boot Environment” (PXE). 
• Local-Area Network (LAN) connection 
• Boot server: DHCP server from Windows NT® 4.0 Server with Service Pack 6a, Windows 2000 or 

Windows Servertm 2003. The boot server must be in the same LAN segment.  
• Recovery server: FTP or HTTP server 
• TFTP server from Scout NG setup. This is installed by selecting the “Recovery” component during 

Scout NG installation. 

7.2 Recovery Settings 

Normally, the update server parameters are set during Scout NG (or Enterprise) installation. If you 
used default settings, no further configuration is required. Go to the next section. 
If you are using a different update server, or if your container path has changed since installation, 
or if you wish to specify the eLux NG IDF to install, you will have to reconfigure the parameters. 
The procedure is described below. 

 
1. Log on as administrator to the Scout Server.  
2. Select Recovery settings from the Options menu. 
3. Enter the update server protocol:  

• HTTP if the update server is an HTTP server. Enter the proxy IP address or name, and 
the proxy port number, if used (optional). 

• FTP if the update server is an FTP server. We recommend you access the FTP server 
using a user account. However, “anonymous” FTP is supported. 

Enter the remaining update server settings: 
• Server Enter the IP address or name of the update server. 
• Username and password. If no username or password is defined for the server, enter 

elux as the password and username. Do not leave blank. 

• Path Enter the following: eluxng/__CONTAINER__ 
The text “__CONTAINER__” is a macro in eLux NG. During the recovery procedure, the 
device’s hardware type will automatically be detected and the macro text 
“__CONTAINER__” will be replaced with the correct container name. 

Migration and Server Transfer Build # 11 21 
 



Migration and Server Transfer Build # 11 22 
 

• Image file Enter the following: recovery__SIZE__.idf 
The text “__SIZE__” is a macro. During the recovery procedure, the device’s flash size will 
automatically be detected and the correct recovery IDF will be installed. Alternatively, you 
can enter the name of the NG IDF you wish to install. Note that in this case the eLux NG 
IDF may not exceed the flash size of the device. 

For more information on macros, please see the Scout NG Administrator’s Guide. 
4. Save the Scout NG (or Enterprise) configuration. 
5. Restart the devices. These settings will be converted to an environment variable and 

transferred to the device. 

7.3 Configuring the DHCP Server for PXE 

During a recovery, the Thin Client loads its boot file over the network from a boot server. The boot 
server is a DHCP server. 
1. Log on as administrator to the computer running the DHCP server. 
2. Open the DHCP manager. 

Windows NT: Start > Programs > Administration (General) > DHCP Manager 
Windows 2000: Start > Programs > Administrative Tools > DHCP 

3. In the DHCP manager, go to the dialog box for configuring options. 
Windows NT: Click to select the scope of the DHCP server you would like to configure. In the 
Options menu, select Global to configure the options for all scopes for that server, or Scope 
to configure the options for that scope. The DHCP options dialog box opens. 
Windows 2000: Click to select either the server options, scope options or a reservation. In the 
Action menu select Configure. In the Options dialog box go to the General tab. 
(Alternatively: Advanced tab > select DHCP Standard options from the Vendor class drop-
down list.)  

4. The following options are standard and should already be configured. If not, please add:  
003 Router:  Enter one or more router IP addresses 
006 DNS Servers:  Enter the DNS server IP address 
015 Domain Name:  Enter the DNS domain name 
 
The following two options are PXE specific and must be configured: 
066 Boot Server Host Name:  Enter the IP address of the TFTP server 
067 Bootfile Name:  Enter pxelinux.0 

This completes the DHCP server configuration. The PXE settings can remain on the DHCP server 
without affecting normal network operation. If the parameters do not change, they only have to be 
configured once. 

7.4 DHCP Options (optional) 

You can configure DHCP server so that Thin Clients will automatically be entered in Scout NG 
Server after the recovery. 
This method is supported by most DHCP servers, including older versions. It uses the standard 
options 222 and 223. If options 222 and 223 are unavailable, you cannot use this method. 

1. Open the DHCP Manager (Start > Programs > Administration (General) > DHCP 
Manager). 

2. Click to select your DHCP server. In the Action menu select Set Predefined Options. 
3. Select DHCP Standard options from the “Option class” drop-down menu. Click Add. The 

Option Type dialog box appears. 
• Name Enter “Scout NG Server” 
• Data type Select “Character string” 
• Code Enter “222” 
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• Description Enter the “Name/IP address of Scout NG Server” 
Click OK and Add to enter a second option (optional): 

• Name Enter “Scout NG group ID” 
• Data type Select “Long” 
• Code Enter “223” 
• Description Enter the “Device group ID on the Scout NG Server” 
Note: Array should not be selected. 
Click OK. 

4. In the DHCP manager, click to select either the server options, scope options or 
reservations. In the Action menu select Configure. In the Options dialog box go to the 
General tab. (Alternatively: Advanced tab > select DHCP Standard options from the 
Vendor class drop-down list.) Configure the two options: 

• 222 Enter the IP address/name of the Scout NG server 
• 223 Enter the Scout NG ID number of the destination group 

7.5 Initiating the Recovery 

A recovery is initiated on the client. The method used to initiate a recovery depends on your 
hardware platform. The device BIOS must support PXE. 
Some – but not all – hardware platforms require you to first set remote boot to PXE in the Thin 
Client’s BIOS (1) and then call PXE from the boot menu (2).  
Other hardware platforms offer a simpler possibility: You initiate a recovery simply by pressing a 
function key upon boot (in most cases, F1). 
See the documentation included with your Thin Client to see what situation applies to you. 
• To configure the protocol on the Thin Client:  
1. Upon boot, press the function key that opens BIOS for your hardware platform. See the 

documentation that was included with the Thin Client if you are unsure (in most cases, F2). 
2. Set “LAN remote boot” to PXE. 
3. Save your settings and exit BIOS. 
 
• To select the protocol from the Thin Client boot menu:  
1. Upon boot, press the function key that opens the boot menu for your hardware platform. See 

the documentation that was included with the Thin Client if you are unsure (in most cases, 
F12). 

2. Select PXE and press ENTER. 
3. A message appears, allowing you to cancel the procedure. To proceed, press one of the 

following keys (keyboard layout is English): 
• A Installs eLux NG for the detected hardware using the corresponding container: 

Futro B 100 UC_GEODE_P1 
Futro B 200 UC_VIA 
Futro C and D UC_INTEL_P3 
Futro S UC_TRANSMETA 

Platform detection is only available for thin clients from Fujitsu Siemens Computers. 
For devices from other manufacturers, this option will not be displayed. 

 
• B Installs eLux NG for PC 

4. The recovery starts. Do not turn off the Thin Client off during a recovery! 
5. After a successful boot, a “Success” message appears and the Thin Client restarts. 
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For normal eLux NG operation, the BIOS settings can remain on the device. 
This completes the recovery. 
 
If you did not set DHCP options as described in step 7.4 DHCP Options (optional) after a 
recovery the devices will initially not be managed. In Scout NG, perform a discovery to re-enter 
devices. Previously registered devices will not change groups. Rather, their status will be updated. 
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8 Migration from eLux 1.x to eLux NG by CD-Recovery 
This section describes how to recover from eLux 1.x to NG via CD recovery. 
A recovery destroys all data on the flash card/hard disk and installs the eLux NG software. It is not 
reversible. It is the only way to install eLux NG on a Thin Client running eLux 1.0. Note: Not available 
for Geode.  

8.1 Requirements 

• eLux NG recovery CD. This is a bootable CD available from your supplier, or the eLux NG 
recovery CD image can be downloaded from the Web site www.myelux.com and burned to a CD 
in ISO format. 

• CD-ROM drive (IDE or USB) 
• Thin Client: BIOS support of CD boot 
• A USB keyboard may not be used with USB CD-ROM 
 

8.2 Recovery Procedure 

1. On the Thin Client, insert the CD. 
2. A warning appears, asking if you want to perform the recovery. (Please note that recovering to 

eLux NG is not reversible and that the terminal will initially be unlicensed!) Click Y to start the 
recovery (or Z or J). 

3. When the recovery has finished, the CD is ejected and the Thin Client reboots. 
If the recovery does not start immediately, confirm that “CD-ROM drive” comes before “harddisk” in the 
BIOS Setup boot options and that you are using the correct CD. 
This completes the eLux NG migration. The following sections provide useful troubleshooting and 
diagnostics information. 
 

http://www.myelux.com/
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9 Diagnostics 

9.1 Licensing eLux NG 

When you update from eLux 1.x to eLux NG, initially the terminal will be unlicensed. This is because 
eLux NG is a new product with a whole new range of features.  
An unlicensed terminal starts in test mode. You may log on to eLux NG 40 times without a license. 
Afterward, you must enter an update license to continue using eLux NG. 
Please see section 10 Licenses for detailed information. 

9.2 Diagnosing Firmware Update 

Helpful Tips  
• Before updating all the devices in your network, we highly recommend testing an update on a 

single device. 
• If the update is interrupted, once you have fixed the problem it is not sufficient to continue where 

you left off. You must start from the beginning. Remove the eLux NG Migration Installer from the 
1.1 IDF, install this image, add the eLux NG Migration installer to the 1.1 IDF, and install this 
image. 

• When editing your IDF, please be aware that new features have been implemented in ELIAS NG. 
For example, due to the new dynamic partitioning feature of eLux NG (this allows you to install 
eLux on hard disks as well as flash cards), the total flash size is shown in the bar at the bottom of 
the screen and there is no warning if you exceed the actual flash size (the wrong flash size will 
cause the update to fail). 

• You can use macros both in the firmware parameters for the new 1.1 IDF and in the ELUXNGURL 
for the new NG IDF. Please be aware that the macros have changed in NG, and inform yourself 
before using them. See the NG manuals for more information. 

9.3 Frequently asked Questions: 

FAQ 
Q: The procedure did not work because I forgot a step. After fixing this, can I continue where I left 
off? 
A: No. You must start from the beginning. Remove the eLux NG Migration Installer from the 1.1 
IDF, install this image, add the eLux NG Migration installer to the 1.1 IDF, and install this image. 
 
Q: The procedure stopped and I don’t know why! 
A: Check the update log. 
 
Q: The update log does not list an error. 
A: The log containing the error was most likely overwritten. There is no way to retrieve this log. To 
prevent this, go to Setup > Firmware for the device and deselect “Check for update on boot”. 
Repeat the procedure. 
 
Q: When I’m done, do I have to re-enter the devices in the manager? 
A: No. The manager setting on the device is not deleted. 
 
Q: The procedure was successful, but now my terminal is unlicensed! 
A: See section 10 Licenses We recommend obtaining update licenses for eLux NG and Scout NG 
in advance. Please be aware that update licenses are not free. 



9.4 Boot Procedure 
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9.5 Diagnosing Network Recovery 

Problem: After beginning a PXE recovery, a DHCP time-out occurs and the terminal just boots.  
Solution: The DHCP server failed to respond. Check the network connection. Check the DHCP 

server’s log file for the client to receive an IP address. Adapt DHCP Server settings if 
necessary.    

 
Problem: The terminal begins a PXE recovery, then boots normally or displays a TFTP time-out 

error: 
TFTP open timeout  

Solution: The TFTP server failed to respond. Check if the TFTP server is available. Check the 
log file of  the TFTPD daemon. Check the router/gateway and boot server settings for 
DHCP.   

 
Problem: After beginning a PXE recovery, the following message is displayed: 

TFTP Error – File not found  
and the terminal just boots.  

Solution: The TFTP server failed to send the bootfile (pxelinux.0). Check bootfile settings for 
your DHCP server and TFTP server log. Check access rights for the TFTP server’s 
root directory.  

 
During a network recovery, package installation will be displayed graphically. You can press CTRL 
– ALT – F4 to leave graphics mode and switch to a text screen. This is useful for troubleshooting, 
to view any error messages that may be displayed. 
 

9.6 Diagnosing CD Recovery 

A USB keyboard may not be used with USB CD-ROM. 
You must use the “eLux NG recovery CD,” which is bootable. It is available from your supplier or 
the CD image can be downloaded from the Web site http:// www.myelux.com and burned to a CD 
in ISO format. 

http://www.myelux.com/
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10 Licenses 
When you update from eLux 1.x to eLux NG, initially the terminal will be unlicensed. This is because 
eLux NG is a new product with a whole new range of features. You will need an update license. 
To manage Thin Clients using Scout eL Server, you need a Scout eL management license. To 
manage Thin Clients using Scout NG, you need a Scout NG management license. 
 

Verify that you have the correct type and number of eLux NG and Scout NG licenses before 
continuing. 

10.1 License Types 

• Scout NG To manage clients running eLux NG, if you did not previously use the Scout NG Server. 
Package size: 250 and 1000 licenses. 

• Upgrade eLux NG  eLux NG+Scout (built-in) 
For < 250 clients, this license is for upgrading from clients with eLux NG to eLux NG+Scout. The 
clients can then be managed by the Scout NG management system. Meaningful when the clients 
are already licenses for eLux NG. 

• Update Scout eL  Scout NG 
If you previously used Scout eL, existing eL licenses can be updated in fixed package sizes of 250 
and 1000. You must have at least 250 or 1,000 activated Scout eL licenses in your database to be 
able to enter the update license. 

• Update eLux 1.x  eLux NG+Scout (built-in)  
For < 250 clients, this license is for  
• updating the desired number of clients from eLux 1.x to eLux NG, 
• updating from Scout eL to Scout NG using the built-in Scout NG management license. 

• Update eLux 1.x  eLux NG To update eLux 1.x clients to eLux NG. You order the number of 
licenses you need and receive one license key for the desired amount. 
Free Updating to eLux NG and Scout NG is free for eLux 1.x clients bought after 1.10.2003. 
Procedure: Logon www.myelux.com, under Service  Product Activation Center  click eLux NG 
Update. You receive the update license for a device after entering the serial number and the host 
ID. This license is not to be activated and must be entered locally on the client. The free update for 
Scout eL is also available here. 

http://www.myelux.com/
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Example 
 
 Say you have an installation with 324 Thin Clients running eLux 1.x. Your Scout eL 

Server contains 1 Scout eL management license for 250 devices, 1 Scout eL 
management license for 50 devices, and 3 Scout eL management licenses for 10 
devices for a total of 330 management licenses. This leaves you with 6 unused 
management licenses, as Scout eL licenses could only be bought in packs. 

 
 
 
  
  BEFORE (eL / 1.1 NETWORK) AFTER (NG NETWORK) 
 Qty License Package Size Qty License Package Size 
 1x  Scout eL  250 1x Upd Scout eL > NG  250 
 1x  Scout eL  50 250x Upd eLux 1.x > NG 1 
 3x  Scout eL  10 74x Upd eLux 1.x > NG + Sct 1 
 324x eLux 1.x     
 

  
After the migration to NG, you have 324 devices to manage and 330 Scout eL 
licenses in your database. You buy 1 Scout NG update license for 250 devices. This 
leaves 74 devices over without a management license. 

 
 

You buy 250 eLux 1.x > NG update licenses and 74 eLux NG + Scout update 
licenses. 
The benefit is that you no longer have to buy a fixed amount of Scout NG 
management licenses. In addition, the built-in license “migrates” with the device 
should you choose to enter it in a different server.In our example, all licenses are to 
be entered in Scout NG. The eLux NG update licenses will be distributed 
automatically, reducing administrator effort. 
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